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ProMA Series User Manual

Without the prior written consent of ZKTeco, no portion of this manual can be copied or forwarded in any
way or form. All parts of this manual belong to ZKTeco and its subsidiaries (hereinafter the "Company" or
"ZKTeco").

ZK T =0 is a registered trademark of ZKTeco. Other trademarks involved in this manual are owned by
their respective owners.

This manual contains information on the operation and maintenance of the ZKTeco equipment. The
copyright in all the documents, drawings, etc. in relation to the ZKTeco supplied equipment vests in and is
the property of ZKTeco. The contents hereof should not be used or shared by the receiver with any third
party without express written permission of ZKTeco.

The contents of this manual must be read as a whole before starting the operation and maintenance of the
supplied equipment. If any of the content(s) of the manual seems unclear or incomplete, please contact
ZKTeco before starting the operation and maintenance of the said equipment.

It is an essential pre-requisite for the satisfactory operation and maintenance that the operating and
maintenance personnel are fully familiar with the design and that the said personnel have received
thorough training in operating and maintaining the machine/unit/equipment. It is further essential for the
safe operation of the machine/unit/equipment that personnel has read, understood and followed the
safety instructions contained in the manual.

In case of any conflict between terms and conditions of this manual and the contract specifications,
drawings, instruction sheets or any other contract-related documents, the contract conditions/documents
shall prevail. The contract specific conditions/documents shall apply in priority.

ZKTeco offers no warranty, guarantee or representation regarding the completeness of any information
contained in this manual or any of the amendments made thereto. ZKTeco does not extend the warranty
of any kind, including, without limitation, any warranty of design, merchantability or fitness for a particular
purpose.

ZKTeco does not assume responsibility for any errors or omissions in the information or documents which
are referenced by or linked to this manual. The entire risk as to the results and performance obtained from
using the information is assumed by the user.

ZKTeco in no event shall be liable to the user or any third party for any incidental, consequential, indirect,
special, or exemplary damages, including, without limitation, loss of business, loss of profits, business
interruption, loss of business information or any pecuniary loss, arising out of, in connection with, or
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relating to the use of the information contained in or referenced by this manual, even if ZKTeco has been
advised of the possibility of such damages.

This manual and the information contained therein may include technical, other inaccuracies or
typographical errors. ZKTeco periodically changes the information herein which will be incorporated into
new additions/amendments to the manual. ZKTeco reserves the right to add, delete, amend or modify the
information contained in the manual from time to time in the form of circulars, letters, notes, etc. for better
operation and safety of the machine/unit/equipment. The said additions or amendments are meant for
improvement /better operations of the machine/unit/equipment and such amendments shall not give any
right to claim any compensation or damages under any circumstances.

ZKTeco shall in no way be responsible (i) in case the machine/unit/equipment malfunctions due to any
non-compliance of the instructions contained in this manual (i) in case of operation of the
machine/unit/equipment beyond the rate limits (iii) in case of operation of the machine and equipment in
conditions different from the prescribed conditions of the manual.

The product will be updated from time to time without prior notice. The latest operation procedures and
relevant documents are available on http://www.zkteco.com

If there is any issue related to the product, please contact us.

ZKTeco Industrial Park, No. 32, Industrial Road,
Tangxia Town, Dongguan, China.

+86 769 - 82109991

+86 755 - 89602394

For business related queries, please write to us at: sales@zkteco.com.

To know more about our global branches, visit www.zkteco.com.
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ZKTeco is one of the world’s largest manufacturer of RFID and Biometric (Fingerprint, Facial, Finger-vein)
readers. Product offerings include Access Control readers and panels, Near & Far-range Facial Recognition
Cameras, Elevator/floor access controllers, Turnstiles, License Plate Recognition (LPR) gate controllers and
Consumer products including battery-operated fingerprint and face-reader Door Locks. Our security
solutions are multi-lingual and localized in over 18 different languages. At the ZKTeco state-of-the-art
700,000 square foot ISO9001-certified manufacturing facility, we control manufacturing, product design,
component assembly, and logistics/shipping, all under one roof.

The founders of ZKTeco have been determined for independent research and development of biometric
verification procedures and the productization of biometric verification SDK, which was initially widely
applied in PC security and identity authentication fields. With the continuous enhancement of the
development and plenty of market applications, the team has gradually constructed an identity
authentication ecosystem and smart security ecosystem, which are based on biometric verification
techniques. With years of experience in the industrialization of biometric verifications, ZKTeco was
officially established in 2007 and now has been one of the globally leading enterprises in the biometric
verification industry owning various patents and being selected as the National High-tech Enterprise for 6
consecutive years. Its products are protected by intellectual property rights.

This manual introduces the operations of the ProMA Series.

All figures displayed are for illustration purposes only. Figures in this manual may not be exactly consistent
with the actual products.

Features and parameters with % are not available in all devices.
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Document Conventions

Conventions used in this manual are listed below:

GUI Conventions

Convention Description
Bold font Used to identify software interface names e.g. OK, Confirm, Cancel.
S Multi-level menus are separated by these brackets. For example, File > Create >
Folder.

For Device

Convention Description
<> Button or key names for devices. For example, press <OK>.
[ Window names, menu items, data table, and field names are inside square
brackets. For example, pop up the [New User] window.
/ Multi-level menus are separated by forwarding slashes. For example,
[File/Create/Folder].
Symbols

Convention

L

Description

This implies about the notice or pays attention to, in the manual.

0

The general information which helps in performing the operations faster.

The information which is significant.

Care taken to avoid danger or mistakes.

The statement or event that warns of something or that serves as a cautionary
example.
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Instruction for Use

Before getting into the Device features and its functions, it is recommended to be familiar to the below
fundamentals.

1.1 How to scan the QR code?

Open the Mobile Credential of ZKBioSecurity App and parallel the phone screen to the device QR code
scanner.

ZKBioSecurity

Note: Place your phone within 15 to 50cm of the device (distance depends on the size of the phone

screen), do not block the device QR code scanner and QR code in the phone screen.

1.2 Standing Position, Posture and Facial Expression

The recommended distance

(
U I The distance between the device and a user whose height is
Lo in a range of 1.55m to 1.85m is recommended to be 0.3 to
2.5m. Users may slightly move forward or backward to

improve the quality of facial images captured.

1.2m
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Recommended Standing Posture and Facial Expression
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_ Note: Please keep your facial expression and standing posture natural while enrolment or verification.

1.3 Palm Registrationy
Place your palm in the palm collection area, such that the palm is placed parallel to the device.

Make sure to keep space between your fingers.

KEEP EFFECTIVE KEEP SPACES DO NOT KEEP DO NOT KEEP DO NOT KEEP
DISTANCE OF BETWEEN YOUR FINGERS PALM OUTSIDE YOUR FINGERS
30 to 50 cm YOUR FINGERS CLOSE COLLECTION AREA FOLD/CURLED
#
. Note:

Place your palm within 30 to 50 cm of the device.
Place your palm in the palm collection area, such that the palm is placed parallel to the device.
Make sure to keep space between your fingers.

Please avoid direct sunlight when using the palm function outdoors. According to laboratory test, the

palm recognition effect is best when the light intensity is not more than 10,000 lux.
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1.4 Face Registration

Try to keep the face in the centre of the screen during registration. Please face towards the camera and
stay still during face registration. The screen should look like this:

i Enroll Face

Correct face registration and authentication method
Recommendation for registering a face

When registering a face, maintain a distance of 40cm to 80cm between the device and the
face.

Be careful not to change your facial expression. (Smiling face, drawn face, wink, etc.)

If you do not follow the instructions on the screen, the face registration may take longer or
may fail.

Be careful not to cover the eyes or eyebrows.

Do not wear hats, masks, sunglasses, or eyeglasses.

Be careful not to display two faces on the screen. Register one person at a time.

It is recommended for a user wearing glasses to register both faces with and without glasses.

Recommendation for authenticating a face

Ensure that the face appears inside the guideline displayed on the screen of the device.

If the glasses have been changed, authentication may fail. If the face without glasses has
been registered, authenticate the face without glasses further. If the face with glasses has
been registered, authenticate the face with the previously worn glasses.
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If a part of the face is covered with a hat, a mask, an eye patch, or sunglasses, authentication
may fail. Do not cover the face, allow the device to recognize both the eyebrows and the

face.

1.5 Finger Placement

Recommended fingers: Index, middle, or ring fingers.

Avoid using the thumb or pinky, as they are difficult to accurately tap onto the fingerprint reader.

n n r

*

_ Note: Please use the correct method when pressing your fingers onto the fingerprint reader for

registration and identification.
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2  Appearance

2.1

ProMA-QR
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No. Description
1 Microphone
2 Camera & Palm
3 2" Display Screen
4 Card Reading Area
5 Doorbell Button
6 Flash
7 QR Code Scanner
8 Speaker
9 Reset
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2.2 ProMA
(7 ) 1
2 ) (ﬁ:]
3
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1 4 5
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IESCREN
No. Description
1 Microphone
2 Camera & Palm
3 2" Display Screen
4 Card Reading Area
5 Doorbell Button
6 Flash
7 Fingerprint Sensor
8 Speaker
9 Reset
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2.3 ProMA-RF
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No. Description
1 Microphone
2 Camera & Palm
3 2" Display Screen
4 Card Reading Area
5 Doorbell Button
6 Flash
7 Speaker
8 Reset
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2.4  Terminal and Wiring Description

2.4.1 Terminal Description

=R

— Hnuuuunnuunn

12V
GND

1
I

nn n --- E E -- --
[e][=][=]=)=)=]=][=]=]=]=]=]s]
e T i [ P H e e T

1 GND
[JWD1-OUT
[—Jwbo-out
[ 485B
[1485A
1 1wD1
1 \wbo
1 GND

—\
[J12v-0UT

Interface ‘ Description
12V
12V Power In
GND
GND
NO1

coM1 Lock

NC1
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AUX1 Auxiliary Input
SEN1 Sensor
BUT1 Exit Button
AL-
Alarm
AL+
BELL-
Bell
BELL+
12V-OUT
Power Out
GND
WD1-OUT
Wiegand Out
WDO-OUT
485B
RS485
485A
IWD1
Wiegand In
IWDO
GND
TX+
TX-
Network Interface
RX+
RX-
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Wiring Description

Power Connection

]

©

)
= ©
(@) (KOEJ
©
10

Recommended power supply

Rating of 12V and 3A

12V

To share the device’s power with other devices, use a power supply with higher current ratings.

Door Sensor, Exit Button, Alarm and Auxiliary Connection

- + Alarm Power

el ——

BELL+
[y BELL-
(@ @) AL+
— Exit Button
Hl) AL-
& A X o
TR BUT1
© = SEN1
= AUX1
—ef 5
I (—) = NC1
] = Door @ ﬂ COMT
@ Sensor[___] E
[CHCH NO1
g 4 GND

COM \ﬁhaf’/ -
S

Detector

Smoke Detector
Power

Page |16 Copyright©2022 ZKTECO CO., LTD. All rights reserved.



ProMA Series User Manual

Lock Relay Connection

The system supports both Normally Opened Lock and Normally Closed Lock. The NO Lock (normally
opened when powered) is connected with ‘NO1" and ‘COM1’ terminals, and the NC Lock (normally closed
when powered) is connected with ‘NC1" and ‘COM1’ terminals. The power can be shared with the lock or
can be used separately for the lock, as shown in the example with NC Lock below:

1) Device not sharing power with the lock 2) Device sharing power with the lock
Sty — 112V — +12V —
12 _ e § DC12V ———GND
AL+ AL+
+ AL- f AL-
"‘ - :
= FR107 :
I BUT1 : BUTT
NC Lock SEN1 § SEN1
AUX1 : @3 — AUX1
- : FR10
bcizv . COM1 NC Lock COM1 —
Lock Power NOT1 NO1
GND : GND

Wiegand Connection

The Wiegand card reader connects to the top 4 pins of the Wiegand terminal and the last two pins are
used by the Access Controller, as shown in the following figure. It sends the credentials to the device via

Wiegand communication.

%

y GND
IWDO

_ WD IWD1
99 485A

WDO

2l

485B
WDO0-OUT _WD0
wD1-oUT|_WD1
GND
12V-OUT

GND Controller

+12V

Wiegand Reader

Note: The QR600 reader is a feature unique to ProMA-QR. For details, please refer to QR600 Code

Reader Quick Start Guide.
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RS485 Connection

The RS485 lets users connect to multiple readers to the device. RS485 can be connected to the terminal, as

shown in the figure below.

ﬁ
] GND
{0 e} IWDO
_| L IWDT1
5@ sese o
485-
© = I— 485B
H - _ WDO
— - WDO-OUT
- 1 WD1-OUT L_WD1 | Access
= Controller
] Q GND e
+12V
12V-OUT

485 Reader

Note: The QR600 reader is a feature unique to ProMA-QR. For details, please refer to QR600 Code
Reader Quick Start Guide.

Ethernet Connection

Connect the device and computer software over an Ethernet cable. An example is shown below:

ZKBio CVSecurity

0

0

)

o

L L LTI i SRR

Default IP address: 192.168.1.201 IP address: 192.168.1.130
Subnet mask: 255.255.255.0 Subnet mask: 255.255.255.0

#

Note: In LAN, the IP addresses of the server (PC) and the device must be in the same network segment

when connecting to WebServer.
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Installation

3.1 Installation Environment

Please refer to the following recommendations for installation.

INSTALL INDOORS AVOID INSTALLATION AVOID DIRECT AVOID USE OF ANY
ONLY NEAR SUNLIGHT HEAT SOURCE
GLASS WINDOWS AND EXPOSURE NEAR THE DEVICE

3.2 Device Installation

ProMA series installations are the same, the following is an example of ProMA.
Attach the mounting template sticker to the wall, and drill holes according to the mounting paper.
Fix the backplate on the wall using wall mounting screws.
Attach the device to the backplate.

Fasten the device to the backplate with a security screw.

p
0
=

DN
® @MY @

@
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Standby Interface

After connecting the power supply, the following standby interface is displayed:

2020-7-2212:03 &8 2020-7-22 22:47 A&

12:03 22:47

2020-7-22 Thursday I020-7-22 Thursday

Welcome Walrnma
Serial IPAddress

192.168.1.201

Ok

The device has a built-in IP address, which can be used for device communication, connection to
WebServer and ZKBio CVSecurity software, etc.

rl

_ Note: The device uses a 2" display screen, which does not support touch operation and is only used to

display status and verification information. All operations such as device information, communication
settings, user management and system settings are operated and set up on WebServer.
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5 Verification Mode

5.1 QR Code Verificationk

In this verification mode, the device compares the QR code image collected by the QR code collector with

all the QR code data in the device.

Tap [Mobile Credential] on the ZKBioSecurity App, and a QR code will appear, which includes employee
ID and card number (static QR code only includes card number) information. The QR code can replace a

physical card on a specific device to achieve contactless authentication. Please refer to Mobile Credential

*x.

Successfully verified:

2020-7-2212:03

A&T®

2020-7-22 12:03 VAN

I{!ﬂ
a

Failed to verify:

2020-7-22 12:03

AS®

Page |22

User 1D : 1
MName : Mike
Successfully verified.

2020-7-22 12:03 VAN 5}

Failed to verify.

Error! Invalid QR Code
Verify : QR Code

S 4
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5.2 Facial Verification

In this verification mode, the device compares the collected facial images with all face data registered in
the device. The following is the pop-up prompt of a successful comparison result.

Successfully verified:

2020-7-22 22:47 O

o

2020-7-22 22:47 VAN

"a
]
| "a

User ID: 1

Name : Mike

Verify : Face
Successfully verified.

Failed to verify:

B
"

2020-7-22 22:47 VAN 2020-7-22 22:47

i
&

Failed to verify.

Error! Invalid Face
Verify : Face

5.3 Palm Verificationyk

This verification mode compares the palm image collected by the palm module with all the palm data

template in the device.

The device will automatically distinguish between the palm and face verification mode. Place the palm in
the area that can be collected by the palm module, so that the device will automatically switch to palm

verification mode.
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Successfully verified:

2020-7-22 22:48 VA1)

Failed to verify:

2020-7-22 22:48 A&

K

2020-7-22 22:48 A&

User ID: 1

MName : Mike

Verify : Palm
Successfully verified.

A >

"a

2020-7-22 22:48 VAN

Failed to verify.

Error! Invalid Palm
Verify : palm

| Note: Palm recognition requires the configuration of a special camera.

5.4 Card Verification

The Card Verification mode compares the card number in the card induction area with all the card number
data registered in the device; The following is the card verification screen.

Page |24
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Successfully verified:

2020-T-22 2247 A6 2020-7-22 22:47 Foi)

{

User 1D : 1
Name : Mike
Verify - Card Verify : Card
Werifying ... Successiully verified.
Failed to verify:
2020-7-22 32:47 VO g )
2020-7-22 22:47 A\ &S
(&i
Failed to verify.
Warify : Card Error! Invalid Card
Yerifying .. Verify : Card

. >

#

__ Note: The ProMA-QR supports Chilean and Argentinean ID PDF417 codes.

5.5 Fingerprint Verification

This method compares the fingerprint of the user that is being pressed onto the fingerprint reader with all

the fingerprint data that is pre- stored in the device.

To enter fingerprint identification mode, simply tap your finger on the fingerprint reader.
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Successfully verified:

2020-7-2222:47

2020-7-22 22:47

Verify : Fingerprint
Yerifying ...

Failed to verify:

2020-7-2222:47

>
*a

Verify : Fingerprint
Yerifying ...

Page |26

User 1D : 1

Name : Mike

Verify : Fingerprint
Successiully verified.

2020-7-22 22:47 VAN i

Failed to verify.

Error! Invalid Fingerprint
Verify : Fingerprint

b J
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Login WebServer

A user can open the web application to set the relevant parameters of the device.

Press and hold the Doorbell Button of the device until the IP pops up.

( N

Open a browser to enter the address to log in to the WebServer, the address is https:// Serial IP
Address:1443. For example: https://192.168.1.201:1443.

*

__ Note: The Serial IP Address of the device for communication can be modified, for details please

refer to Communication Settings.

2020-7-22 7347 AL

y

&
L]

22:47

2020-7-22 Thursday
WalrAama

|_ SerialIPAddress

| |

[ |

w i3 188200

oK
=[@] & ]
zk https://192.168.1.201:1443/1 x =
<« C 2« | https://192.168.1.201:1443 ; ® :
I, ’
z«  https://192.168.1.201:1443 X

Q  https://192.168.1.201:1443 - Goolge - Search

zx  https://192.168.1.201:1443/login.html - https://192.168.1.201:1443/start.html

z«  https://192.168.1.201:1443/login.html - https://192.168.1.201:1443/login.html
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#

. Note:

After logging in for the first time, users need to change their original password and log in again before
they can use it, please refer to Change Password.

In order to retrieve the password easily, please register a super admin first, please refer to 8.1 User
Registration.
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7  Forgot Password

Method 1 (When there is a super admin):

If you forgot the password of WebServer, you can reset it by the registered super admin. The detailed steps
are as follows:

Click the icon on the login interface.

[=[=] =
ZK https://192.168.163.201:1443, X + v
€ 2> C A T2 | htps)//192.168.163.201:1443/login.html 2 Y O 2

8) User Name

@] Password

On the pop-up page, enter the relevant information of the super admin user as prompted.

=[=]
2ZK 7KTeco management panel x + 7
&« C A =2 | hitps//192.168.163.201:1443/lostpassword.html =2 % O a
Admin verification
Please input admin user ID. 1 Enter super admin user id
Password .. Enter super admin user possword
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192.168.163.99:1443 B

Password reset, please login again!

After a successful reset, enter the default account and password (account: admin, password:

admin@123) on the login interface to log in.

8 admin

Y admin@123 ® G

For security reasons, please change your password after successfully logging in.

ZKT=- o

System Info . - .
4 After the first login, please change the password, otherwise, the webserver function

Change Password is locked.

Enter the Current
Password
Enter a New

Password

Confirm
Password

*

__ Note: The super admin must exist.
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Method 2 (When there is not a super admin):

If the network of the device is normal and ZKBio CVSecurity has been connected, you can reset the
password by sending the super admin account and password from the server.

Click Personnel > Person > New on the ZKBio CVSecurity Server.

New ®
Personnel 1D 1 I Department® Department Name -
First Name Last Name
Gender e - Mobile Phone
Certificate Type | - Certificate Number
Birthday Email
Hire Date Paosition Name hd
Device Verification Password | i Card Number &
Biometrics Type F
4 Access Control Time Attendance Elevator Control Flate Register Passage Sefting FaceKiosk Personnel Detail »
Levels Settings Superuser Yes -
General Device Operation Role Administrator -
Extend Fassage
Disabled
Set Valid Time
Add Select All Unselect All

Cancel

After registering the information of the super admin, click Save and New.

Click Access > Device > Control > Synchronize All Data to Devices to synchronize all the data to
the device including the new users.
_ Note: For other specific operations, please refer ZKBio CVSecurity V6600 User Manual.

After the data synchronization is successful, you can reset the password with the newly registered
super admin. The operation steps are the same as method 1.

Method 3:

If the device has not registered a super admin and cannot connect to the server, please contact our after-
sales technicians to help retrieve the password.
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8 User Management

8.1 User Registration

3.1.1 Basic Information

Click All Users on the WebServer.

In this interface, you can register the User ID, Name, Rights, Password, Card Number and Access Control
Role of the new user, click Confirm to save.

System Info

Basic Info
UserID 2
Name Jake
User Mgt. Rights Normal User v

All Users
i Password

Advanced Settings :
Card Number 1190130

Access Control Role 3

=l A

Online Registration

Face
Palm

Fingerprint

a0

User ID The user ID may contain 1 to 14 characters by default. It can be numbers, letters,
symbols, etc.
Name A name can be up to 63 characters.
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Rights

Set the role for the user as either Normal User or Super Admin.

Super Admin: The Super Admin owns all management privileges in the
WebServer.

Normal User: If the Super Admin is already registered in the WebServer,
then the Normal Users will not have the privileges to manage the system
and can only access authentication verifications.

Password

Set the user's registration password.

Card Number

Enter the card number manually, after registering the user's card number, the
user can swipe the card for verification. Or behind the card number, click
Register, and the device will display the card registration interface in real time,
swipe the card underneath the card reading area. The registration of the card
will be successful.

_ Note: The ProMA-QR supports Chilean and Argentinean ID PDF417 codes,
as well as slave QR600 reader.

Access Control Role

The Access Control Role sets the door access privilege for each user, new users
will be added to Group 1 by default, which can be reassigned to other required
groups. The system supports up to 10 access control groups.

_ Note:

During the initial registration, you can modify your ID; you cannot be modifying the registered ID

once after the successful registration.

If the message "Setup failed!" pops up, you must choose a different User ID because the one you

entered already exists.

Online Registration

In this interface, you can register the User's Face, Palm¥ and Fingerprint¥. The verification mode can

only be registered after the basic information is confirmed.

Card Type Settings

Video Intercom

SIP Settings

Serial Comm

Face

Autotest
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Palm

Fingerprint
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» Register Face

In the current interface, behind the face bar, click Register, and the device will display the face registration
interface in real time.

Online Registration

Face

ol \
Palm

Fingerprint

® Please face towards the camera and position your face inside the white guiding box and stay still
during face registration.

* A progress bar shows up while registering the face and “Enrolled Successfully” is displayed until the
registration completes.

* If theface is registered already then, the “Duplicated Face” message shows up.

The registration interface is as follows:

2020-7-22 22:47 A& Enroll Face

#

__ Note: While registering a face, the system automatically captures a picture as the profile photo. If you

do not register a profile photo, the system automatically sets the picture captured during registration as
the default photo.

» Register Palmx%

In the current interface, behind the palm bar, click Register, and the device will display the palm
registration interface in real time.
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Online Registration

Face Register

Palm Register

Fingerprint Register \

Palm Regist_ration Palm Registration

»  Register Fingerprintx

In the current interface, behind the fingerprint bar, click Register, and the device will display the
fingerprint registration interface in real time, press your finger onto the fingerprint sensor of the device,
and follow the instructions to complete the registration.

Online Registration

Fingerprint Register \
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Remote Enroll Finge... Remote Enroll Finge...
Press finger third time Press finger third time
56 =k
= ‘W o
— / — 3
— 21 — N/
= \¥ = \¥

For fingerprint pressing operation, please refer to Finger Placement.

8.2 Search for Users

Click All Users on the WebServer, click the search bar to enter the required retrieval keyword (where the
keyword may be the user ID, surname or full name) and the system will search for the related user
information.

System Info

User Mgt.

Device Info
. e a
Device Capacity
Firmware Info [m| User ID Name Rights Card Number \ Verification Method Operation

User Mgt. ~
g O 1 Mike Super Admin 1311129248 B (]_‘ & '{"‘7 Change User Inio
All Users . .
O 2 Jake Nomal Use 1190130 ‘_EI <L’ Change User Info
Advanced Settings
1K) | < n > >l

COMM.

3.3 Edit User

On the All Users interface, select the required user from the list and click Change User Info to edit the
user information.

System Info

User Mgt.
Device Info
. a
Device Capacity
Firmware Info O User ID Name Rights Card Number Verification Method Operation

User Mgt. 5 m
L O 1 Mike Super Admin 1311129248 5 ([ ] '31"7 Change User Info

All Users . .
O 2 Jake Normal Use 1190130 LE] ([ Change User Info
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System Info

Device Info
Device Capacity
Firmware Info
User Mgt.
All Users
Advanced Settings
COMM.
Cloud Service Setup
Date Setup
System
Card Type Settings
Video Intercom
SIP Settings
Serial Comm
Face
Autotest

Wiegand Setup

Access Control Options

Change User Info

User ID
Name
Rights
Password

Card Number

Access Control Role

Online Registration

Face

Palm

Fingerprint

Mike

Super Admin

1311129248

1

- Register
Register

Register

L Note: The process of editing the user information is the same as that of adding a new user, except that

the User ID cannot be modified. The process in detail refers to 8.1 User Registration.

3.4 Delete User

On the All Users interface, select the required user from the list and click Delete User to delete the user.

Here individual deletion and batch deletion is available.

System Info
Device Info
Device Capacity
Firmware Info

User Mgt.

All Users

Advanced Settings

COMM.

Cloud Service Setup
Date Setup

System

Card Type Settings
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User Mgt.

O User ID

1

Name

Rights

o &

Card Number Verification Method QOperalion

5 |_ f:,\ {'} Ghange User Info

‘_ 5 ]_ Ghange User Info

Ll
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9 Advanced Settings

9.1 Communication Settings
Click COMM. on the WebServer.

Change the IP address of the device as needed, click Confirm to save, and the device will automatically
synchronize the IP information.

System Info

IP Setup
Device Info
DHCP
Device Capacity
i ) [P Address 192 168.163.99
Firmware Info
Subnet Mask
User Mgt. 2552552550
All Users Gateway 192.168.163.1
Advanced Settings DNS 14114114114

COMM.

Cloud Service Setup

DHCP Select whether to obtain the IP Address by automatically.
The default IP address is 192.168.1.201. It can be modified according to network
IP Address o=
availability.
The default Subnet Mask is 255.255.255.0. It can be modified according to
Subnet Mask -
network availability.
The Default Gateway address is 0.0.0.0. It can be modified according to network
Gateway oo
availability.
DNS The default DNS address is 0.0.0.0. It can be modified according to network
availability.

£

__ Note: After the IP address of the device is changed successfully, you need to log out of the currently

WebServer and log in again to the IP address you just changed to connect to the device. For WebServer
login details, please refer to Login WebServer.

Page |38 Copyright©2022 ZKTECO CO., LTD. All rights reserved.



ProMA Series User Manual

9.2 Cloud Server Setting
Click Cloud Service Setup on the WebServer.

Cloud Server Setup was used to connect to the ZKBio CVSecurity software, please refer to 12.1 Set the
Communication Address.

System Info Cloud Server Settings

Device Info

) ) Enable Domain Name
Device Capacity

. - Cloud Server Address 192.168.161.21
Firmware Info
User Mgt. Cloud Service Port 8099
HTTPS " @

All Users
Proxy Server Setup

Advanced Settings

COMM.

Cloud Service Setup

Function Name Description

Enable Once this function is enabled, the domain name mode “http://...”
Domain Server Address | will be used, such as http://www.XYZ.com, while “XYZ" denotes the
Name domain name (when this mode is turned ON).

Disable Server Address | IP address of the ADMS server.

Domain
Name Server Port Port used by the ADMS server.
HTTPS Based on HTTP, transmission encryption and identity
authentication ensure the security of the transmission process.
When you choose to enable the proxy, you need to set the IP
Proxy Server Setup y proxy, ¥

address and port number of the proxy server.

9.3 Date Setup
Click Date Setup on the WebServer.
¢ Click Manual to manually set the date and time and click Confirm to save.

* Select Open or Close the Daylight Saving Mode function. If opened, set the Daylight Saving Time
and End of Daylight Saving.
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System Info
Device Info
Device Gapacity
Firmware Info

User Mgt.

All Users

Advanced Settings

COMM.

Cloud Service Setup

Date Setup

System

Card Type Settings

Video Intercom

SIP Settings

Serial Comm

Face

Autotest

Wiegand Setup

Access Control Options

Date Setup

Configuration Mode

Device Date and Time

Daylight Saving Mode
) By Date/Time
Daylight Saving Time
End of Day Lightsaving
By Week/Day
Start Time

End Time

9.4 System Settings

Click System on the WebServer.

It helps to set related system parameters to optimize the accessibility of the device.

System Info
Device Info
Device Capacity
Firmware Info

User Mgt.

All Users

Advanced Settings

COMM.
Cloud Service Setup
Date Setup

System

Page |40

System

Volume
Language
Communication Protocol

Device Type
Alphanurneric User ID
Display [P when booting
User ID Masking

Display Verification Name

Display Verification Mode

Auto

Close

Manual

14:51:02 (YYYY-MM-DD - HH:MM:SS)

70

English v
PUSH Protocol v
A&C PUSH v
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Volume

Adjust the volume of the device which can be set between 0 and 100.

Language

Select the language of the WebServer and device.

Communication
Protocol

Set the communication protocol of the device

Device Type

Set the device as an access control terminal or attendance terminal.

Note: After changing the device type, the device will delete all the data and
restart, and some functions will be adjusted accordingly.

Alphanumeric User
ID

Enable/Disable the alphanumeric as User ID.

Display IP when
booting

Enable/Disable the function of display IP when booting.

User ID Masking

When enabled, and then the user is successfully compared and verified, the
User ID in the displayed verification result will be replaced with an * to achieve
secure protection of sensitive private data.

Display Verification
Name

Set whether to display the username in the verification result interface.

Display Verification
Mode

Set whether to display the verification mode in the verification result interface.

s

| Note:

After selecting the language and clicking Confirm, the device will automatically reboot and display

the changed language.

Then WebServer will not display the switched language until the device reboots and log in again.

9.5 Card Type Settings

Click Card Type Settings on the WebServer.

The device supports 125kHz and 13.56MHz band cards, please select the corresponding card type

according to your needs.
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System Info

Device Info
Device Capacity
Firmware Info
User Mgt.
All Users
Advanced Settings
COMM.
Cloud Service Setup
Date Setup
System
Card Type Settings
SIP Settings

Serial Comm

Card

Type Settings

125kHz

EM4102

HID
PROX

13.

56MHz

FELICA

HID
ICLASS

MIFARE

NFC
p2P

9.6 Video Intercomy

Click Video Intercom on the WebServer.

The video intercom function supports LAN and WAN, LAN is suitable for PC and WAN is suitable for mobile

phone.

System Info
Device Info
Device Capacity
Firmware Info

User Mgt.

All Users

Advanced Settings

COMM.

Cloud Service Setup
Date Setup

System

Card Type Settings

Video Intercom
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Video Intercom

Work Mode

Cloud Server Address

Cloud Service Port

Calling Timeout(s)

LAN + TUYA v

192.168.163.75

2585

Copyright©2022 ZKTECO CO., LTD. All rights reserved.



ProMA Series User Manual

LAN Video Intercom Function Settings

Installing ZKBio VMS Plugin in the ZKBio CVSecurity Software

While installing, select the "VMS" module of the ZKBio CVSecurity software to install, as shown in the
following installation interface.

(] AD Integration

Access & P ~
& [ LED
Advanced Access ] B .

Elevator (] %%i [J Arteco&C2P Integration

evator >
Attend 0 ~ [ Middle Table
endance
Line Integration

Visitor (] U g

(] FaceKiosk

Consumption [ ]
i = (] Parking

Patrol [] OT -
emperature m
SMS ] - -

[ < Back ] [ Cancel ] I Next =

*

L Note: The Video module and the VMS module cannot be selected at the same time.

Double-click on the provided ZKBioVMSPlugin_sqlite.exe file to install the ZKBio VMS Plugin.

#

_ Note: The ZKBio CVSecurity software and ZKBio VMS Plugin need to be opened simultaneously to recognize

the intercom function.

Configuration Parameters

Set the required parameters correctly to ensure a connection between the device and the software.
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Add site on the Video-VMS plugin

Double click the O icon to open the Video-VMS Plugin. Click *Choose site > Site management >
Add on the login interface. Then, enter the Name, IP address, and Port to add a site, as shown in
the following figure.

@ZK BIO VMS Plugin

. site Setting
admin FEy
200000000

Add site

Name IP address Port Name: = VNS

192.168.163.61

AN

IP Address: Enter the local IP address.
v' Port: The default port is 5252.

Enter the username and the password after adding the site and click Login to login the Video-
VMS plugin. The username and the initial password are both admin.

@ZKBiO VMS Plugin

admin

seene
[# Rem [ Auto login

*

__ Note: When the Video-VMS plugin is connected successfully to the ZKBio CVSecurity, the password

changes synchronously to the admin user password of the ZKBio CVSecurity.
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Configure the connection path of the ZKBio CVSecurity and VMS plugin

Click Video > maintenance Configuration > Browser Controls on the ZKBio CVSecurity software to change the
path, as shown in the following image:

) 7t (I G
Video View > |

& ik & i M

Personnel Access Attendance Consumption Elevator

0 4

Device Management >

|3]

Decoding On The Wall >

it @ & B igi

@ search >
Visitor Parking Fatrol Personal Card  Entrance
Control
(3' Intelligent >
| + P 1
o [ 1
@ statistics > FaceKiosk Temperature Intelligent System
Detection Analytics
& Video Patrol >

Maintenance Configur... ~ Service Center

Developer Log

Client Request Log

CU Request Browser Controls

: Current Version : Not Installed Or Failed To Load.

File Storage Location

Log Parameter Settings

Debug log

No -

Access log

No v

VMS Connection Path

v URL: "http://local IP address: port"

v' Port: Itis 8489 by default (e.g., http://192.168.163.61:8489).

Server Path

v" URL: "http://server IP address: port"

v Port: The port is the service port set during installation (e.g., http://192.168.163.61:8098) (not the
ADMS port).

Configure the parameters on the ProMA

Click Cloud Server Setup on WebServer to set the server address and server port, i.e, the IP
address and port number of the server after the software is installed. If the device communicates
with the server successfully, the icon s is displayed in the upper right corner of the standby
interface.
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System Info

Cloud Server Settings
Device Info

i 5 Enable Domain Name
Device Capacity

: Cloud Server Address 192.168.163.61
Firmware Info
User Mgt. Cloud Service Part 8098
HTTPS

All Users
Proxy Server Setup

Advanced Settings

COMM.

Cloud Service Setup

Click Video Intercom to set the server address and server port.
v" Cloud Server Address: Enter the ZKBio CVSecurity installation IP address.

v' Cloud Server Port: The port is the service port set during installation (not the ADMS port).

System Info .
4 Video Intercom
Device Info

Device Capacity Work Mode LAN + TUYA .

Firmware Info Cloud Server Address 192 168,163 61

User Mgt. Cloud Service Port 8098

All Users Calling Timeout(s) 10

Advanced Settings

COMM.

Cloud Service Setup

Date Setup

System

Card Type Settings

Video Intercom

Adding device on the ZKBio CVSecurity software

Click Access > Device > Device > Search to add the device on the ZKBio CVSecurity software.
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((JZKBio CVSecurity

rg Access Device

v
2 a 3 Gl
Personnel Access Consumption Elevator
1/0 Board
up
Door "
it ® & igi S .
Reader Visitor Parking Patrol Entrance FaceKiosk
Control
Auxiliary Input
Auxiliary Output En E,- 14
Event Type Temperature Intelligent Intelligent System Service Center
Detection Video Scene
Daylight Saving Time
Search x
2 ; nd? Download Search Tools to Local Disk
--------------------- Searched devices count:1
Total Progress Number of devices added:1
IP Address Device Type Serial Number ®
IP Address MAC Address Subnet Mask Gateway Add... Serial Number Device Type Set Server Operations
192.168.1.201 255.255.255.0  192.168.1.1 ProMA
New x
Device Name” ProMA
Communication Type® (s) TCPNP () RS485
IP Address” 192 . 168 .1 . 201
Communication port* 4370
Communication Password
Icon Type”® Door v

A\ The current system communication f

2)

Control Panel Type One-Door Access Co. .

Area” Area Name

Add to Level

Clear Data in the Device when
Adding

A\ [Clear Data in the Device when Adding] will delete data in the device
(except event record), please use with caution!

OK Cancel

&5

After the device is added successfully to the access module, it automatically adds to the video

module. User can click Video > Video Device > Search to view.
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Cq Video View >
Device Management v
Camera

Group Management

(X Decoding OnThe Wall >

@ Search >
{F Intelligent >
@  Sstatistics >
2 Video Patrol >

@ Maintenance Configur... >

Video Management / Device Management / Device

Device

Name

G Refresh  TF New
Name

124

126

< Grouping Device

Q ¢ Device Name
W Delete QSearch € Sync Camera More T Refresh  TF New
Device Type Status Subscription Status Device Name
AS1700 offiine o 10.8.12.211
ZRERE 116_tes5
134
133

50 rows per page

10.8.51.13000

10.8.51.135

10.8.61.13188E

mEE

Jump To 1 /1 Page  Total of 2 records 1-10

@ Delete  Q search

1P Address

Channel Code  Status
offline
2 offline
3 Offline
4 Offline
5 s}
6 offline:
7
8 offline
[ offline
10 offline
50 rows per page

<! Adjustment Area

Camera Type

Fixed Camera

Tube Machine

Tube Machine

Tube Machine

Tube Machine

Tube Machine

Tube Machine

Fixed Camera

Hemisphere

Fixed Camera

Jump To 1

Q <

More
Type 1P Ad
CBL223-CO1 108

C2150-10-S1U  10.8.

D2150-10-1-P(3.6/ 105!

D2150-10-1-P(3 6/ 10.8

D2150-10-1-P(3.6/ 105

D2150-10-1-P(3 6/ 10.8

D2150-10-1-P(3.6 10.8.!

DDS522-01 10.8.
C3250-10-S1U  10.8.
CBL223-C01 10.8.

/1 Page  Total of 10 recc

_ Note: If the device is not added to the Video module, please check whether the parameter settings are

correct.

Video Preview on the ZKBio CVSecurity Software

Click Video > Video Preview to enter the preview interface of the device.

i) 7t Ed

Video View v

Personnel
Video Playback

il @

Visitor Parking

B8 Device Management >

3 Decoding On The Wall >

@ search >
(& Intelligent >
@ statistics >
2 Video Patrol >

@l Maintenance Configur... >
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B &

Attendance  Consumption

& B

Patrol Personal Card  Entrance
Control

Not Installed Or Failed To Load.

If The Instaliaton Is Not Successful, Flease Contact Technical Support To Get The Plugin

‘The Plugin Has Been Instalied, Please Try To Restart The Browser And Retry The Current Operation

1 The Problem Stil Exists, It Is Recommended To Check The Network O Reinstall The Plugin.

@ admin ~
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Make a Call on the Device

Tap {1 icon on the ProMA to make a call.

2021/08/19

ZK

The server page pops up the call window by default, as shown in the following figure.
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Function Description

Function

Name

Description

It is the Answer key, the user can click to answer the current call. After answering,

enter the window during the call, and turn on audio and video by default.

@

It is the Hang up key. After hanging up, immediately end the current call.

It is the Ignore key, used to ignore the current call. Click it to close the call window,
and the icon n in the upper right corner will display the number of pending calls,
like this [=§. The user can click the € icon in the drop-down menu to open the call
window of the current device again and choose to answer, as shown following figure.

&1

192.168.162.87  22:20:12 &)

It is the Hang up key, used to hang up the current call.

It is the Snapshot key, used to take a snapshot.

It is the Remote Open key, used to open the door remotely. The default lock drive
time is 5 seconds.

s

| Note: If the device preview interface is opened on the ZKBio CVSecurity software, the call interface will

no longer be displayed in this call window.

9.6.2 Connecting to ZKBio Talk Software

Download and install the ZKBio Talk software. Then, keep the parameter settings of ZKBio CVSecurity

software unchanged for the relevant settings. (Please refer to LAN Video Intercom Function Settings).

Following are the steps to connect ZKBio Talk to the ZKBio CVSecurity software:

Firstly, change the parameter on the ProMA. Click Video Intercom on the WebServer to change the
server address and server port, as shown in the following figure.

Page |50

Copyright©2022 ZKTECO CO., LTD. All rights reserved.




ProMA Series User Manual

All Users Video Intercom

Advanced Settings

Work Mode LAN + TUYA v
COMM.

Cloud Server Address 192 168 163 61
Cloud Service Setup
e Cloud Service Port 8098

Calling Timeout(s) 10

System

Card Type Settings m
Video Intercom
Serial Comm E

Face

Autotest

v"  Server Address: Enter the current server installation IP address.

v' Server Port: The default server port is 25550.

Double click the icon 0 to open the ZKBio Talk software. When the device-side video intercom
parameters are set correctly, the device automatically pushes the device list on the left, as shown in
following figure.

K 7KBio Talk
Alias IP Address

192.168.1.... 192.168.1....

® Incall ® Incoming Call

® Standby
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A user can click on . to preview the video on the right. On clicking . or . icon, a user can close
the preview screen. No action is taken when . is clicked.

Alias IP Address

192.168.1.... 192.168.1....

® Incall ® Incomins Call

® Standby

When a user tap 1 icon on the ProMA to make a call, the software interface displays the IP address of
the calling device in yellow.

Alias IP Address

V5L 192.168.16...

L)

15:37

2021/08/19

® Incall ® Incoming Call

® Standby
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When the user clicks the . icon to answer the call, the IP address is displayed in green while on the
call. The call duration is also displayed just above the icon.

Alias

18929681

® Incall

® Standby

Function Description

. It is the Snapshot key, used to take a snapshot.

It is the Remote Open key, used to open the door remotely. The default lock
drive time is 5 seconds.

9.6.3 Connecting to ZSmart APP

¢ Adding Device on the ZSmart APP

After downloading and installing the ZSmart APP on your phone, create a User account initially with your

Email ID. After creating the User account, log in to the App, and tap m or o icon on the top

right corner of the screen to add a device. The process is as follows:

Click Add Device on the Home page.
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() Add Device

Welcome Home (& Create Scene

All Devices

i FIARST TN

Click Video Intercom on WebServer.

All Users Video Intercom
Advanced Settings
Work Mode LAN + TUYA v
COMM.
Cloud Server Address 192 168 163 61
Cloud Service Setup
Date Setup Cloud Service Port 8098
system Calling Timeout(s) 10

Card Type Settings m

Video Intercom
Serial Comm
Face

Autotest

Wiegand Setup
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rA
Tap the - “ icon in the upper right corner.

All Users Video Intercom

Advanced Settings

Work Mode LAN + TUYA v
COMM.

Cloud Server Address
Cloud Service Setup

Date Setup Cloud Service Port

System Calling Timeout(s)
Card Type Settings

Video Intercom

Serial Comm

Face

Autotest

Wiegand Setup

Access Control Options
Device Management

Device Management

Update Firmware

Change Password

Operation Log

Download Firmware Logs

16:51

Cancel

Added.

E? Video Access Terminal Welcome Home

Adding device...

Ensure that the device is powered on

All Devices

E Video Access Terminal
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Make a Call on the Device

Tap 11 icon on the ProMA to make a call. After receiving the call, slide up to open the door remotely.

2021/08/19

Surveillance Screen

Find the bundled ProMA in ZSmart APP to view the screen in real time.

il 56

Video Access Terminal

o) B

16 KB/S

Gallery
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Function Description

Function
Name

Description

I:l_l Tap it to switch to the full screen.

Capture a picture to the photo alboum in the App.

@ Tap it to talk to people in front of the device.

Manually record a video to the photo album in the App.

I:I)) To mute or unmute the sound from the device.

Gallery Review the recorded photos when detecting the motion.

Theme Color | Change the Ul theme to light mode or dark mode.

UnLock Remote door opening and viewing door opening records.

9.7 Onvif Settings

s

| Note: This function needs to be used with the network video recorder (NVR) %.

Click ONVIF Settings on the WebServer.

ONVIF Settings

Advanced Settings

COMM.
Enable Authentication (

Cloud Service Setup
User Name

Date Setup

Password

System

Server Port 8000
Card Type Settings

Video Intercom

ONVIF Settings

9.7.1 Network Video Recorder (NVR)

After the NVR device is powered on, connect the NVR wiring port via Ethernet cable.

Click [Video Management] > [Device] > [Search] on ZKBio CVSecurity server to add NVR.
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(UZKBio CVSecurity |

Q Video View s
-
m @ \.m. HH < Groupir
E.J Device Management v
Personnel Access Attendance Consumption Elevator
Devic
Caners 83 C) & B M o
Visitor Parking Patrol Personal Card Entrance
Group Management Caniol
8 i
FaceKiosk Temperature System
Detection
C& Video View > Video Management / Device Management / Device
Device ¢ Grouping
' Device Management v
Camera ~ _ S =
O Refresh Z# New @ Delete [Q Search} & Sync Camera - More ~ O Ref
Group Management ) feeeeee o= o
Name Device Type Staj scription Status
Step 4
® 124 AS1700 Onlire
125 NVR300 Online ]
126 ZKNVR Online o
Auto Search
| :
i ------------------- D
Total Progress Searched devices count: 1
Address Version Device Model Name Port User Name Password
10.8.14.128 NVR2.0 ZKNVR 10.8.14.128 8081 | test [--------
i
!
Enterthe usernameand %
User Name Password
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The successfully added NVR are displayed in the device list, as shown in the following figure.

(JZKBio CVSecurity = %

Cq video View > Video Management / Device Management / Device
Device
B Device Management v
E - i
Camera . -
O Refresh =# New © Delete Q Search & Sync Camera
g Mngsemt Name Device Type Status
® 124 AS1700 Online /]
125 NVR200 Online o
126 ZKNVR Online (]
127 ZKNVR Online e

9.7.2 Addthe ProMA to NVR

- More ~

<  Grouping

Device |

C Ref

Subscription Status

1. Click [Video Management] > [Device] > [Search] on ZKBio CVSecurity server to select the NVR to

which you need to add the ProMA in the device list.

(JZKBio CVSecurity ]

l-‘& Video View

S a

Personnel

8 W
%' Device Management v
Attendance

Access Consumption

iti @ &

Visitor

&

Personal Card

Camera

Patrol

Group Management Parking

S

FaceKiosk

=

Video - Intelligent
Management"‘m

Temperature
Detection

Cd Video View > Video Management / Device Management / Device
Device
Y Device Management v
- =
Device
Camera 3 —
O Refresh #New W Delete Q Search & Sync Camera
Group Management
Eiani. Name Device Type Status
e 1
i@ ProMA H ProMA Online /]

125 Step 4 pp Online (]

Page |59

HH < Groupi
Elevator

Devic

W S R
Entrance
Control

H

System

< Groupir

Devic

- More ~ CR

Subscription Status
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2. In the device list, click [Search] > [Start Search], the NVR automatically search to the same LAN IPC
camera through the network cable, add it.

B

Auto Search

Total Progress

1
Protocol Type | ONVIF v |i [IPAddress = 2 2 - : . .
IP Address Port Step 7 Type Drive User Name Password

S

10.8.51.121 80 ONVIF
Step 8

Searched devices count:6

.

10.8.51.118 8000 ONVIF

10.8.51.125 443 ONVIF
10.8.51.126 8082 ONVIF
10.8.51.132 80 ONVIF
10.8.51.98 80 ONVIF

User Name Password
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9.7.3 Linkage

After configuring the access controller, NVR and ProMA, you can set the event trigger linkage for illegal
access, verification of door opening, alarm, abnormality, etc., which will be displayed in the corresponding
event list of monitoring.

Click [Access] > [Linkage] > [Add] on the server to set the linkage related parameters. For more details,
please refer to ZKBio CVSecurity User Manual.

((JZKBio CVSecurity

E} Access Device > g

o o=
.'l Access Rule v
Personnel Attendance Consumption Elevator
Time Zones

Holidays Ba @ W 0|

Visitor Parking Patrol Personal Card Entrance
Access Levels ol
SetAccess By Levels

] > > &,
Set Access By Person — En E' '}H
FaceKiosk Temperature Video Intelligent System

Set Access By Department Detection Management Analytics
Interlock @

i Service Center

New x

Linkage Name” Test

' Device" | cs-a00
Linkage Trigger Conditions*] Add _| input Point{  _ ! Step 6
Without Mask - Access bamrecr" B
1B 10814

i

<« | Output Point | Video Linkage E-mail »

Door Step 9 Auxiliary Output
B 10.8.14.94Q-1

Action type Close - Action type Close -

Save and New “ Cancel
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New X
Linkage Name® Test Device” 10514940
Linkage Trigger Conditions* Add Input Point*
B4 Without Mask - Access Denied B Any
B 10.8.14.94Q-1
‘ Output Point ! Video Linkage ! E-mail ,
Step 10
Video Video length 30 s(10-180)
Capture In the monitoring page immediately pep up
Display time 10 s(10-60)

A Make sure that the corresponding input point linkage is bound to available video channel, otherwise the video linkage function will not
work!

Cancel

Motion detection warning

2022-09-16 14:39:03
125_HoloSens SDC
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9.8 SIP Settingsk

*

__ Note: This function needs to be used with the indoor station Vpad A2 %.

Click SIP Settings on the WebServer.

System Info

Upload Configuration Data
Device Info

Update documents:

All Users Download Configuration Data

Device Capacity

Firmware Info

User Mgt.

Advanced Settings
COMM.

Cloud Service Setup

SIP Settings

Date Setup
System
Calling Delay(s) 30
Card Type Settings
Talking Delay(s) 50
SIP Settings
Encryption Disabled v
Serial Comm
Transport Protocol
Face p HeP N
dtmf

Autotest

Wiegand Setup Verify TLS Certificate

SIP Server
Access Control Options

Device Management m

Device Management

Calling Shortcut Settings

Update Firmware

Change Password
Call Mode Multi-Tenants Calling v

Operation Log

Download Firmware Logs L) 192.168.163.199

] 192.168.163.102

] 192.168.163.103

] 192.168.163.104

] 192.168.163.105
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9.8.1 SIP Settings

SIP Settings

Calling Delay(s) 10

Talking Delay(s) 60

Encryption Disabled ~

Transport Protocol uDP v

dtmf

Verify TLS Certificate

SIP Server
Function Name Description
Calling Delay(s) Set the time of call, valid value 30 to 60 seconds.

Talking Delay(s) Set the time of intercom, valid value 60 to 120 seconds.

Encryption When enable, this communication of video intercom will be encrypted.

Transport Protocol | Set the transport protocol between ProMA and indoor station Vpad A2.

The value of WebServer is the same as the value of DMTF in the device in order

dtmf .
to unlockiit.

Verify TLS Certificate | Enable/Disable the verify TLS certificate.

Select whether to enable the server address. Once you have connected to the
SIP Server server, you can call it by entering the username of the indoor station.

For details, please refer to 9.8.3 SIP Server.

The ProMA and the indoor station to achieve video intercom there are two modes, respectively, the LAN
and SIP server. Either method can be selected to achieve SIP video intercom, when the LAN and SIP server
are set up at the same time, clicking the doorbell button of ProMA will start the SIP server first.
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Local Area Network Use

Set the IP address on the indoor station, tap Menu > Advanced > Network > 1. Network > 1. IPv4.

- Network v’
Accounts 1.Connection Mode ‘ Static IP ‘
Network 2.1P Address | 192.168.163.199 |
Security 3. Mask | 255.255.255.0 |
Maintenance 4. Gateway ‘ 192.168.163.1 ‘
Device 5.Primary DNS ‘ 114.114.114.114 ‘

6.Secondary DNS | 8888 |
o

*

_ Note: In LAN, the IP addresses of the indoor station and the ProMA must be in the same network

segment.

Download Configuration Data

Click Download to download the file and set the parameters of the video intercom.

Download Configuration Data
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intercomm.csv x

S https://192.168.163.129:1443/action/downloadintercomm
S
el

Show in the folder

Open the downloaded file and manually modify the video intercom parameters as needed. Save
the set parameters in order to synchronize the parameters to ProMA.

s

| Note: The IP Address/Subnet Mask/Gateway must be the same as the indoor station to be connected.

G13 - Q. fx

A B C D
IF _Address Snbnet Masl CAtEway Dialing Number
192, 165, 165, 189 295, 208, 255, 192, 168, 165. 1 101
192,168, 163, 102 293, 233, 235, 192.168.163. 1 102
182,168, 163. 103 298, 255, 255, 192,168,163, 1 103
192.168.163. 104 255, 255, 255, 192.168.163. 1 104
192, 168, 165,105 295, 205, 255, 192,168, 165.1 1035

S I I R N R N
o D D DT

intercomm.csv

Upload Configuration Data

Click Uploading... to find the configured parameters for the video intercom.

Upload Configuration Data

Update documents:

Uploading ... Confirm
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€ 77 [
-
() [ pesop » = [ 42 |[searchfor Deskton »|
=- 0 @

N

F
F

?

=
S

mn

emmm

intercomm.csv

R

P

File @u: » [xus e s -

2| Open ' Cancel

Click Confirm to sync the parameters to ProMA.

Calling Shortcut Settings

The configured parameters will be synchronized to the WebServer (ProMA), supporting one-to-one and
Multi-Tenants Calling.

Calling Shortcut Settings

Call Mode Multi-Tenants Calling v

a

192.168.163.199

192.168.163.102

192.168.163.103

192.168.163.104

O|o|jgolo

192.168.163.105

Once the indoor station is configured with the network, the video intercom function can be realized by tap
the n icon on the ProMA.
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15:37.

2021/08/19

SIP Server

On WebServer, enable SIP Server, and enter the server parameters for the indoor station Vpad A2.

The set up SIP server is not affected by the network and responds more quickly. Can call the room number
accurately according to the configured parameters.

SIP Server -
SIP Settings
Server Address 20.205.119.174
Serial Comm
Server Port 5060
Face
JA, User Name 109
Wiegand Setup Password
Access Control Options realm 3CXPhoneSystem
Device Management
Confirm
Device Management
B tiateE mniears Calling Shortcut Settings
Change Password
Call Mode Multi-Tenants Calling v
Operation Log
Download Firmware Logs [ m | 192 168.163.199 &
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Once the SIP Server is set up correctly, you can call the account name of the indoor station.

15:37.

2021/08/19

XX oy

For details on the operation and use of the indoor station, please refer to the indoor station user manual.

9.9 Serial Comm

Click Serial Comm on the WebServer.

All Users
Serial Comm

Advanced Settings
COMM. Serial Port
Cloud Service Setup Baudrate

Date Setup

System

Card Type Settings

SIP Settings

Serial Comm

Face

Page |69

Master Unit v

115200 v
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No Using: No communication with the device through the serial port.

RS485 (PC): Communicate with the device through the R5485 serial port.

Serial Port Master Unit: When RS485 is used as the function of the "Master unit", it can be
connected to a card reader.

DM10: Communicate with the device through the DM10 serial port.

There are 5 baudrate options at which the data communicates with the PC.
They are: 115200 (default), 57600, 38400, 19200 and 9600.

The higher the baudrate, the faster is the communication speed, but also less
Baudrate reliable.

Hence, a higher baudrate can be used when the communication distance is
short; when the communication distance is long, choosing a lower baudrate is
more reliable.

9.10 Face Parameters

Click Face on the WebServer.

All Users Face

Advanced Settings

LN Threshold Value 74
COMM.

1:N Match Threshold for Masked

68

Cloud Service Setup People

1:1 Threshold Value 83
Date Setup
System Face Enrollment Threshold 70
Card Type Settings Face Pitch Angle 10
SIP Settings Face Rotation Angle 25
Serial Comm Image Quality .
Face

Minimum Face Size a0
Autotest

LED Light Trigger Value 50
Wiegand Setup

Motion Detection Sensitivity 4
Access Control Options

Anti-flicker Mode 50Hz -

Device Management

Live Detection

Device Management
Anti-spoofing Using NIR
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Face

Minimum Face Size a0
Autotest
LED Light Trigger Value 50
Wiegand Setup
Motion Detection Sensitivity 4
Access Control Options
Anti-flicker Mode 50Hz v

Device Management

Live Detection
Device Management
Anti-spoofing Using NIR

Update Firmware
P Binocular Live Detection Threshold 50

Change Password
WDR

[]

Operation Log Save Photo as Template !

Download Firmware Logs
:

Under face verification mode, the verification will only be successful when the
similarity between the acquired facial image and all registered facial templates
is greater than the set value.

1:N Threshold Value
The valid value ranges from 0 to 100. The higher the thresholds, the lower the

misjudgment rate, the higher the rejection rate, and vice versa. It is
recommended to set the default value of 74.

1:N Match Threshold | The higher the thresholds, the lower the misjudgment rate, the higher the
for Masked People | rejection rate, and vice versa. It is recommended to set the default value of 68.

Under 1:1 verification mode, the verification will only be successful when the
similarity between the acquired facial image and the user’s facial templates

enrolled in the device is greater than the set value.

1:1 Threshold Value
The valid value ranges from 0 to 100. The higher the thresholds, the lower the

misjudgment rate and the higher is the rejection rate, and vice versa. It is
recommended to set the default value of 63.

During face enrolment, 1: N comparison is used to determine whether the user

has already registered before.
Face Enrollment
Threshold When the similarity between the acquired facial image and all registered facial

templates is greater than this threshold, it indicates that the face has already
been registered.
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Face Pitch Angle

Face Rotation Angle

Image Quality

Minimum Face Size

LED Light Triggered
Value

Motion Detection
Sensitivity

Anti-flicker Mode

Live Detection

Live Detection

Threshold

Anti-spoofing Using
NIR

Page |72

The pitch angle tolerance of a face for facial registration and comparison.

If a face’s pitch angle exceeds this set value, it will be filtered by the algorithm,
i.e. ignored by the terminal thus no registration and comparison interface will
be triggered.

The rotation angle tolerance of a face for facial template registration and
comparison.

If a face’s rotation angle exceeds this set value, it will be filtered by the
algorithm, i.e. ignored by the terminal thus no registration and comparison
interface will be triggered.

Image quality for facial registration and comparison. The higher the value, the
clearer the image requires.

Required for facial registration and comparison.

If the minimum size of the captured figure is smaller than this set value, then it
will be filtered off and not recognized as a face.

This value can be understood as the face comparison distance. The farther the
person is, the smaller the face is, and the smaller the face pixel will be obtained
by the algorithm. Therefore, adjusting this parameter can adjust the furthest
comparison distance of faces. When the value is 0, the face comparison
distance is not limited.

This value controls the on and off of the LED light. The larger the value, the
more frequently the LED light will be turned on.

It is to set the value for the amount of change in a camera’s field of view, which
is known as potential motion detection that wakes up the terminal from
standby to the comparison interface.

The larger the value, the more sensitive the system would be, i.e. if a larger
value is set, the comparison interface is much easier and the motion detection
frequently triggered.

Used when WDR is turned off. This helps reduce flicker when the device’s
screen flashes at the same frequency as the light.

Detecting the spoof attempt using visible light images to determine if the
provided biometric source sample is really a person (a live human being) or a
false representation.

Facilitates to judge whether the captured visible image is really a person (a live
human being). The larger the value, the better the anti-spoofing performance
using visible light.

Using near-infrared spectra imaging to identify and prevent fake photos and
video attacks.
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Binocular Live
Detection Threshold

Facilitates to judge whether the captured visible image is really a person (a live
human being). The larger the value, the better the anti-spoofing performance
using visible light.

WDR

Wide Dynamic Range (WDR), which balances light and extends image visibility
for surveillance videos under high contrast lighting scenes and improves object
identification under bright and dark environments.

Save Photo as
Template

Select whether to save the registered photo.

#

L Note: Improper adjustment of the exposure and quality parameters may severely affect the

performance of the device. Please adjust the exposure parameter only under the guidance of the after-

sales service personnel of our company.

9.11 Autotest

Click Autotest on the WebServer.

It enables the system to automatically test whether the functions of various modules are working normally.

All Users

Advanced Settings

COMM.

Cloud Service Setup
Date Setup

System

Card Type Settings
SIP Settings

Serial Comm

Face

Autotest

Test Face

Autotest

Test Face

T T T T

Test Fingerprint Sensor

Click Test Mode, the ProMA device will display the Test Face interface in real time, click End of Testing to

exit the test.
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Test Face

98

BacSasse o0
After opening the test mode, the upper left corner of the device screen will display the value of the face in real
time, the higher the value, the better quality of the face.

Test Fingerprint Sensor

Click Start, the ProMA device will display the Test Fingerprint interface in real time, click End to exit the test.

Test Fingerprint Sen...

Put the finger to test,press
the ESC key to exit the test

9.12 Wiegand Setup

Click Wiegand Setup on the WebServer.

It is used to set the Wiegand input and output parameters.
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FYES Wiegand Setup

Advanced Settings ®Wiegand Input

COMM. OWiegand Output
Wiegand Format

Cloud Service Setup

26 Wiegand26 v
Date Setup

34 No Using A
System

36 No Using hd
Card Type Settings

37 i
SIP Settings No Using v
Serial Comm 0 No Using v
Face 64 Mo Using v
Autotest Wiegand Bits 26 v
Wiegand Setup ID Type User ID o

Access Control Options

All Users Wiegand Setup

Advanced Settings

OWiegand Input
® Wiegand Output
Wiegand Format

COMM.

Cloud Service Setup

26 Wiegand26 ~
Date Setup

34 No Using v
System

36 No Using hd
Card Type Settings

37 i
SIP Settings No Using v
Serial Comm 0 No Using v
Face 64 No Using A
Autotest Wiegand Bits 2 -
Wiegand Setup ID Type User ID -

Access Control Options
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Wiegand Format Its value can be 26 bits, 34 bits, 36 bits, 37 bits, 50 bits and 60 bits.

Wiegand Bits The number of bits of the Wiegand data.

ID Type Select between the User ID and card number.

9.13 Access Control Options
Click Access Control Options on the WebServer.

On the Access Control interface to set the parameters of the control lock of the terminal and related
equipment.

Access Control Terminal:

All Users Access Control Options
Advanced Settings
Door Lock Delay(s) 5
COMM.
Door Sensor Delay(s) 10
Cloud Service Setup
Door Sensor Type Normal Close(NC) v

Date Setup

System Master Device In .

Card Type Settings Slave Device Out v
Video Intercom

Serial Comm

Face

Autotest

Wiegand Setup

Access Control Options

Function Name Description

The length of time that the device controls the electric lock to be in unlock
Door Lock Delay(s) | state.
Valid value: 1~99 seconds; 0 seconds represents disabling the function.

If the door is not locked and is left open for a certain duration (Door Sensor
Door Sensor Delay(s) = Delay), an alarm will be triggered.

The valid value of Door Sensor Delay ranges from 1 to 255 seconds.
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There are three Sensor types: None, Normal Open, and Normal Closed.
None: It means the door sensor is not in use.
Door Sensor Type Normally Open: It means the door is always left open when electric power is

on.

Normally Closed: It means the door is always left closed when electric power is
on.

Master Device

While configuring the master and slave devices, you may set the state of the
master as Out or In.

Out: A record of verification on the master device is a check-out record.

In: A record of verification on the master device is a check-in record.

Slave Device

While configuring the master and slave devices, you may set the state of the
slave as Out or In.

Out: A record of verification on the slave device is a check-out record.

In: A record of verification on the slave device is a check-in record.

Attendance Terminal:

All Users

Advanced Settings

COMM.

Cloud Service Setup
Date Setup

System

Card Type Settings
Video Intercom
Serial Comm

Face

Autotest

Wiegand Setup

Access Control Options
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Access Control Options

Door Lock Delay(s) 10
Door Sensor Delay(s) 10

Door Sensor Type Mormal Close(NC) v
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Function Name

Door Lock Delay(s)

Description

The length of time that the device controls the electric lock to be in unlock
state.

Valid value: 1~255 seconds; 0 seconds represents disabling the function.

Door Sensor Delay(s)

If the door is not locked and is left open for a certain duration (Door Sensor
Delay), an alarm will be triggered.

The valid value of Door Sensor Delay ranges from 1 to 255 seconds.

There are three Sensor types: None, Normal Open, and Normal Closed.

None: It means the door sensor is not in use.

Door Sensor Type Normally Open: It means the door is always left open when electric power is
on.

Normally Closed: It means the door is always left closed when electric power is
on.

Page |78 Copyright©2022 ZKTECO CO., LTD. All rights reserved.



ProMA Series User Manual

10 Device Management

10.1 Device Management

Click Device Management on the WebServer.

All Users Device Management

Advanced Settings

Clear Administrator Confirm
COMM.

Cloud Service Setup
Restart Confirm

Date Setup

System Reset Confirm

Card Type Settings

Close SSH Confirm
SIP Settings

Serial Comm
Delete All Data Confirm

Face

Autotest Delete Access Control Confirm
Wiegand Setup
Access Control Options

Device Management

Device Management

Function Name Description

Clear Administrator Choose whether to change the super administrator into a normal
user.
Restart Choose whether to restart the device.

The Reset function restores the device settings such as
communication and system settings to the default factory settings
(this function does not clear registered user data).

Reset ‘

__ Note: After reset, the IP of the device is restored to the original
192.168.1.201, please refer to 9.1 Communication Settings to modify
the IP.

Page |79 Copyright©2022 ZKTECO CO., LTD. All rights reserved.



ProMA Series User Manual

Close SSH SSH is used to enter the background of the device for maintenance,
choose whether to close the SSH.
To delete the information and attendance logs/access records of all
Delete All Data . g
registered users.
Delete Access Control To delete the access control data from the ProMA.

10.2 Updata Firmware
Click Updata Firmware on the WebServer.

Select an upgrade file and click Confirm to complete firmware upgrade operation.

All Users Update Firmware

Advanced Settings

Please copy content from checksum.txt.

COMM. |

Cloud Service Setup Update documents:

Date Setup ~ Uploading ...

System '
= |
Card Type Settings
SIP Settings
Serial Comm
Face
Autotest
Wiegand Setup
Access Control Options
Device Management
Device Management

Update Firmware

s

L Note: If the upgrade file is needed, please contact our technical support. Firmware upgrade is not

recommenced under normal circumstances.
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10.3 Change Password
Click Change Password on the WebServer.

In this interface, you can change the password and reset the password of WebServer.

All Users Change Password
Advanced Settings Enter the
Current
COMM. Password
Cloud Service Setup
Enter a New
Date Setu
: Password
System
Confirm
Password

Card Type Settings
SIP Settings m
Serial Comm

Face

Reset Password

Autotest
Wiegand Setup Enter the
Current
Access Control Options Password
. Reset
Device Management Password

Device Management

Update Firmware

Change Password
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10.4 Operation Log
Click Operation Log on the WebServer.
All the user’s operation records on the device or WebServer are saved. Users can search and download these logs

by time.

All Users Operation Log

Advanced Settings

Start Time End Time
COMM. .
=N
Cloud Service Setup
) ; ) Original New
Operator Operation Time Object Result
Date Setup Value Value

System

Card Type Settings

SIP Settings

Serial Comm

Face

Autotest

Wiegand Setup

Access Control Options

Device Management

Device Management

Update Firmware

Change Password

Operation Log

Download Firmware Logs
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10.5 Download Firmware Logs
Click Operation Log on the WebServer.

In this interface, you can select download the main, biometric, or dev.log.

All Users Download Firmware Logs
Advanced Settings .
9 Please select or enter the log file name main.log v
main_log
COMM. biometric.log
devs.log

Cloud Service Setup

Date Setup

System

Card Type Settings

SIP Settings

Serial Comm

Face

Autotest

Wiegand Setup

Access Control Options

Device Management

Device Management

Update Firmware

Change Password

Operation Log

Download Firmware Logs
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System Information

Click System Information on the WebServer.

In this interface, you can view the data capacity, device and firmware information of the current device.

System Info
Device Info
Device Capacity
Firmware Info
User Mgt.
All Users
Advanced Settings
COMM.
Cloud Service Setup
Date Setup
System
Card Type Settings

Video Intercom

System Info
Device Info
Device Capacity
Firmware Info

User Mgt.

All Users

Advanced Settings

COMM.

Cloud Service Setup
Date Setup

System

Card Type Settings

Video Intercom
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Device Info

Device Name
Serial Number
MCU Version
MAC Address

Face Algorithm

FPalm Algorithm
“ersion

Platiorm Info
Manufacturer

IManufacture Date

Device Capacity

User {used/max)
Admin User
Password

Face (used/max)
Palm (used/max)

Card (used/max)

T&A Record
(used/max)

T&A Photo
(used/max)

Blocklist Photo
(used/max)

Profile Photo
(used/max)
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System Info

Firmware Info

Device Info

Device Capacity Firmware Version ZA 30-N

Firmware Info Bio Service ‘er 2.1.14-20221108
User Mgt. Push Service er 2.0.335-20220623
All Users
System Version zam180 v3.2.0.5 Mar 30 2022 15:358:49 CST
Advanced Settings
Standalone Service ‘er 2.1.6-2021081
COMM.
Dev Service ‘er 2.0.1-20221108
Cloud Service Setup
Web Service ver 2.0.2.005-20221108
Date Setup
System V1 Service Ver 1.0.8-20221103
Card Type Settings Licdm Service e 3-20210927

Video Intercom

1)

Mainit Service

Serial Comm

Libopts Service Ver 1.06-20210324

Function Name Description

Displays the device's name, serial number, MCU version, MAC address, fingerprint

Device Info ] L . . .
and face algorithm version information, platform and manufacturer information.

Displays the current device's user storage, password, palm, fingerprints, card
Device Capacity | and face storage, administrators, attendance records, attendance and forbidden list
photos.

Firmware

. Displays the firmware version and other version information of the device.
Information
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Connect to ZKBio CVSecurity Software

12.1 Set the Communication Address

Click COMM. > IP Setup in the WebServer to set the IP address and gateway of the device.

#

(L Note: The IP address should be able to communicate with the ZKBio CVSecurity server,

preferably in the same network segment with the server address)
In the WebServer, click Cloud Server Setup to set the server address and server port.

Server address: Set the IP address as of ZKBio CVSecurity server.

Server port: Set the server port as of ZKBio CVSecurity (The default is 8808).

System Info

IP Setup
Device Info S
| DHCP i
Device Capacity ! \
1
1 ]
| [P Address 192.168.163.99 i
Firmware Info | !
H I
L} ]
! Subnet Mask EE DEE 9EE -
User Mgt. i 255.255.255.0 i
1 g .
: 1
All Users i Gateway 192 168 163 1 ! Enter the
1
) : i IP Info.
Advanced Settings i DNS 114.114.114.114 !
COMM.
: 1 1
Cloud Service Setup ST :m;
e d
Date Setup
System Info -
4 Cloud Server Settings
Device Info e eTee e ess st s ssn e s sttt st e s e ———. %
1 1
E Enable Domain Name i
Device Capacity ! !
L +
E Cloud Server Address 192.168.161.21 i
Firmware Info H H
1 1
1 ]
] 1
1} + ]
1] Mat. 1 Cloud Service Port 8099 i
s : i Enter the
- HTTPS 1
All Users ! i Server Info.
1 1
L} I

Proxy Server Setup

__________________________________________________________

Advanced Settings

COMM.

Cloud Service Setup

Date Setup

System
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Login to ZKBio CVSecurity software, click System > Communication Management >
Communication Monitor to set the ADMS Service Port, as shown in the figure below:

ZK CVSecurity 3 % O admin ~

System Management

@ Authority Management

3 System / Communication management / Cemmunication Monitor

Adms Service Settings
Server Side Network Condition

Communication mana...

Adms Service Port

Device Commands

Communication Device

Product

Autharized device

Project control file version

None

Turn on encrypted transmission

No Yes

Server Side Network Condition

Whether the Internet connection is normal

Yes

12.2 Add Device on the Software

Add the device by searching. The process is as follows:

Click Access > Device > Search, to open the Search interface in the software.

Click Search, and it will prompt Searching.......

After searching, the list and total number of access controllers will be displayed.

Search x

No device found? Download Search Tools to Local Disk

Total Progress

IP Address
IP Address

192.168.1.201

Page |87

Searched devices count:1

100% Number of devices added:1
Device Type Serial Number
MAC Address Subnet Mask Gateway Add Serial Number Device Type Set Server Operations
255.255.255.0 192.168.1.1 ProMA This device has bee
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Click Add in operation column, a new window will pop-up. Select Icon type, Area, and Add to Level
from each dropdown and click OK to add the device.

Mobile Credential %

After downloading and installing the App, the user needs to set the Server before login. The steps are
given below:

In ZKBio CVSecurity > System > System Management > Parameters, set Enable QR Code to
“Yes”, and select the QR code status according to the actual situation. The default is Dynamic, the
valid time of the QR code can be set.

ZKBio CVSecurity i % © aomin v
System Management v System / System Management / Parameters

Operation Log
QR Code Setting

Database Management DateTime Fermat Settings

A2 Enable QR Code
E-mail Management No Yes
Dicticnary Management Qrcode Type
Data Clsaning Static Dynamic
Audio File Valid Time:
30 sacond(30-200)

Certificate Type
Print Template a

System Monitoring

DateTime Format Settings

Date

2022-01-01 -

Time

00:00:00 A

On the Server, choose System > Authority Management > Client Register to add a registered

App client.
Mew x
Client Type® APFP Client-Administr_. -
Reqgistration Code”™ 1C40FD
Cancel
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Register QR-code

mr i
[&

Cancel

3. Open the App on the Smartphone. On the login screen, tap Server Setting and type the IP
Address or the Domain Name of the Server, and its Port Number.

4. Tap the QR Code icon to scan the QR code of the new App client. After the client is identified
successfully, set the Client Name and tap Connection Test.

5. After the network is connected successfully, tap Save.
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Server Setting

0

ZKBioSecurity
Mobile

http://11(

6066

native

Testing Connection

The Mobile Credential function is only valid when logging in as an employee, tap on Employee to

switch to Employee Login screen. Enter the Employee ID and Password (Default: 123456) to login.

6. Tap Mobile Credential on the App, and a QR code will appear, which includes employee ID and

card number (static QR code only includes card number) information.

The QR code can replace a physical card on a specific device to achieve contactless authentication

to open the door.

10:26 9

al 4G @

(UZKBio@m:ty @3

can be used for
wide range;ﬁapplication

Attendance Attendance Mobile
Calendar Statistics Credential
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When using this function for the first time, the App will prompt to authorize the modification of screen

brightness settings, as shown in the figure:

Do you allow the app to change
the screen brightness? If not, the
app might not work properly.

Cancel QK

The QR code refreshes automatically for every 30s and supports manual refresh.

10:31+ il 4G T
< Mobile Credential

¥ Manual refresh of QR Code

*

__ Note: For other specific operations, please refer to ZKBioSecurity Mobile App User Manual.
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Appendix 1

Requirements of Live Collection and Registration of Visible

Light Face Images

It is recommended to perform registration in an indoor environment with an appropriate light
source without underexposure or overexposure.

Do not shoot towards outdoor light sources like door or window or other strong light sources.

Dark-color apparels which are different from the background color are recommended for
registration.

Please show your face and forehead, and do not cover your face and eyebrows with your hair.

The digital photo should be straight-edged, colored, and half-portrayed with only one person, and
the person should be uncharted and casual. Persons who wear eyeglasses should remain to put on
eyeglasses for photo-taking.

Do not wear accessories like scarf or mask that may cover your mouth or chin.

Please face right towards the capturing device, and locate your face in the image capturing area as
shown in Image 1.

Do not include more than one face in the capturing area.

50cm - 80cm is recommended for capturing distance adjustable subject to body height.

Enroll face

Please move and adjust your face on the register area

Image1 Face Capture Area
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Requirements for Visible Light Digital Face Image Data

The digital photo should be straight-edged, colored, half-portrayed with only one person, and the person
should be uncharted and in casuals. Persons who wear eyeglasses should remain to put on eyeglasses for
getting photo captured.

Eye Distance

200 pixels or above are recommended with no less than 115 pixels of distance.
Facial Expression

Neutral face or smile with eyes naturally open are recommended.
Gesture and Angel

Horizontal rotating angle should not exceed £10°, elevation should not exceed £10°, and depression angle
should not exceed £10°.

Accessories

Masks or colored eyeglasses are not allowed. The frame of the eyeglasses should not cover eyes and
should not reflect light. For persons with thick eyeglasses frame, it is recommended to capture two images,
one with eyeglasses and the other one without the eyeglasses.

Face

Complete face with clear contour, real scale, evenly distributed light, and no shadow.
Image Format

Should be in BMP, JPG or JPEG.
Data Requirement

Should comply with the following requirements:

White background with dark-colored apparel.

24bit true color mode.

JPG format compressed image with not more than 20kb size.

Resolution should be between 358 x 441 to 1080 x 1920.

The vertical scale of head and body should be in a ratio of 2:1.

The photo should include the captured person’s shoulders at the same horizontal level.
The captured person’s eyes should be open and with clearly seen iris.

Neutral face or smile is preferred, showing teeth is not preferred.

The captured person should be clearly visible, natural in color, no harsh shadow or light spot or
reflection in face or background. The contrast and lightness level should be appropriate.
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Appendix 2

Privacy Policy

Notice:

To help you better use the products and services of ZKTeco (hereinafter referred as “we”, “our”, or “us”) a

smart service provider, we consistently collect your personal information. Since we understand the

importance of your personal information, we took your privacy sincerely and we have formulated this

privacy policy to protect your personal information. We have listed the privacy policies below to precisely

understand the data and privacy protection measures related to our smart products and services.

Before using our products and services, please read carefully and understand all the rules and

provisions of this Privacy Policy. If you do not agree to the relevant agreement or any of its terms,

you must stop using our products and services.

.

Collected Information

To ensure the normal product operation and help the service improvement, we will collect the

information voluntarily provided by you or provided as authorized by you during registration and

use or generated as a result of your use of services.

1.

User Registration Information: At your first registration, the feature template (Fingerprint
template/Face template/Palm template) will be saved on the device according to the device
type you have selected to verify the unique similarity between you and the User ID you have
registered. You can optionally enter your Name and Code. The above information is necessary
for you to use our products. If you do not provide such information, you cannot use some
features of the product regularly.

Product information: According to the product model and your granted permission when you
install and use our services, the related information of the product on which our services are
used will be collected when the product is connected to the software, including the Product
Model, Firmware Version Number, Product Serial Number, and Product Capacity Information.
When you connect your product to the software, please carefully read the privacy policy
for the specific software.

Product Security and Management

1.

When you use our products for the first time, you shall set the Administrator privilege before
performing specific operations. Otherwise, you will be frequently reminded to set the
Administrator privilege when you enter the main menu interface. If you still do not set the
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Administrator privilege after receiving the system prompt, you should be aware of the
possible security risk (for example, the data may be manually modified).

All the functions of displaying the biometric information are disabled in our products by default.
You can choose Menu > System Settings to set whether to display the biometric information. If
you enable these functions, we assume that you are aware of the personal privacy security risks
specified in the privacy policy.

Only your user ID is displayed by default. You can set whether to display other user verification
information (such as Name, Department, Photo, etc.) under the Administrator privilege. If you
choose to display such information, we assume that you are aware of the potential
security risks (for example, your photo will be displayed on the device interface).

The camera function is disabled in our products by default. If you want to enable this function
to take pictures of yourself for attendance recording or take pictures of strangers for access
control, the product will enable the prompt tone of the camera. Once you enable this function,
we assume that you are aware of the potential security risks.

All the data collected by our products is encrypted using the AES 256 algorithm. All the data
uploaded by the Administrator to our products are automatically encrypted using the AES 256
algorithm and stored securely. If the Administrator downloads data from our products, we
assume that you need to process the data and you have known the potential security risk. In
such a case, you shall take the responsibility for storing the data. You shall know that some data
cannot be downloaded for sake of data security.

All the personal information in our products can be queried, modified, or deleted. If you no
longer use our products, please clear your personal data.

Others

You can visit https://www.zkteco.com/en/index/Index/privacy protection.html to learn more about

how we collect, use, and securely store your personal information. To keep pace with the rapid

development of technology, adjustment of business operations, and to cope with customer needs,

we will constantly deliberate and optimize our privacy protection measures and policies. Welcome

to visit our official website at any time to learn our latest privacy policy.
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Eco-friendly Operation

1.1[])‘ The product's "eco-friendly operational period" refers to the time during which this
product will not discharge any toxic or hazardous substances when used in accordance
with the prerequisites in this manual.

The eco-friendly operational period specified for this product does not include batteries or
other components that are easily worn down and must be periodically replaced. The
battery's eco-friendly operational period is 5 years.

Hazardous or Toxic substances and their quantities

Hazardous/Toxic Substance/Element

e+ | erury | Codmiom | LCC | e | Diphe B

(Cr6+) (PBB) (PBDE)
Chip Resistor X O O O O O
Chip Capacitor X O O O O O
Chip Inductor X O O O O O
Diode X O O O O O
Ezswponent "y & © % © ©
Buzzer X O O O O O
Adapter X O O O O O
Screws O O O X O O

O indicates that the total amount of toxic content in all the homogeneous materials is below the
limit as specified in SJ/T 11363—2006.

x indicates that the total amount of toxic content in all the homogeneous materials exceeds the limit
as specified in SJ/T 11363—2006.

Note: 80% of this product’'s components are manufactured using non-toxic and eco-friendly
materials. The components which contain toxins or harmful elements are included due to the
current economic or technical limitations which prevent their replacement with non-toxic materials
or elements.
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